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About This Manual
Introduction
This manual describes how to install, set up, and use FitPlus for Windows Fit Test Software
version 2.0 and higher. FitPlus for Windows is intended for use with the PORTACOUNT Plus
Model 8020. Instructions for setting up the PORTACOUNT with FitPlus software appear in
Chapter 3, Getting Started.

Organization
This manual is organized as follows:
Chapter

Description

1

Introducing FitPlus
for Windows Fit Test
Software
Getting Started

Introduces FitPlus for Windows Fit Test Software and describes its
functions and features.

Conducting a Fit
Test - Basic
Procedures
Using the FitPlus for
Windows Menu
Options

Provides the basic procedures for conducting a fit test.
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3

4

Provides instructions for installing the FitPlus software and setting
up the PORTACOUNT Plus Model 8020.

Provides a detailed description of each of the FitPlus menu options.

Conventions
The following conventions are used throughout this manual:
Convention

Description

Boldface

Menu options and dialog box fields are shown in boldface type.

R

Key names, such as R, are shown in keyboard type.

Underline

Menu items can be selected with the mouse or by pressing the A key and the
shortcut key for the menu or option. The shortcut key is underlined on the screen
display and in this manual. For example, to select the File menu, you can press
AF.

v

Related Publications
When using this manual and FitPlusTM for Windows software, you may need to refer to your
Windows®, Windows® 95, or Windows NT® documentation. You may also need to refer to the
TSI PORTACOUNT® Plus Operation and Service Manual.
The latest version of FitPlus for Windows and the latest version of this manual are available for
download from the TSI Web site:
http://www.tsi.com

Trademarks
•
•
•

vi

Microsoft, Windows and Windows 95, and Windows NT are registered trademarks of
Microsoft Corporation.
PORTACOUNT is a registered trademark of TSI Incorporated.
FitPlus is a trademark of TSI Incorporated.

Chapter 1
Introducing FitPlusTM For Windows Fit Test Software
FitPlus for Windows fit test software runs under either Windows 3.x, Windows 95, or Windows
NT. The software is designed for use with the PORTACOUNT® Plus Model 8020, and expands
the features available with the DOS-based version of FitPlus software. This chapter introduces
the FitPlus for Windows features, and briefly describes the tasks you can perform with the
software.

FitPlus for Windows Features
In addition to the Windows interface, features provided by FitPlus for Windows include:
•

Selection of the person to be fit tested from a database using a mouse. You no longer have to
re-key the same names again and again.

•

Separate databases for employees, respirators, exercise protocols, and fit test results. You
also can merge databases, and can add fit-test data manually.

•

Expanded report capabilities, including a tickler feature indicating who is due for a fit test.
There is also a single page report for each test subject, user-designed reports, and other
reports.

•

Automated daily diagnostic checks.

•

A real-time fit factor display for use in employee respirator training.

•

A database locking capability to prevent tampering.

•

Support for the Model 8095 N95-Companion accessory.

FitPlus for Windows Tasks
FitPlus for Windows software allows you to perform the following tasks. Each task is described
briefly. Instructions for performing these tasks appear in Chapter 3, “Conducting a Fit Test,” and
Chapter 4, “Using the FitPlus for Windows Menu Options.” The tasks are:
•

Conducting a fit test
FitPlus for Windows software opens in daily check mode, followed automatically by the first
step of the fit test. Fit testing comprises five basic steps: selecting a test subject; selecting a
respirator; selecting an exercise protocol; entering mask size and operator information; and
running the fit test. An optional sixth step lets you view the fit test results before beginning
the next test. These steps are discussed in detail in Chapter 3.

•

Performing daily diagnostic checks
You can run diagnostic checks on the PORTACOUNT Plus, including the particle check, zero
check, maximum fit factor check, and valve check. You either can print or save the results of
these checks for permanent record keeping.

•

Conducting respirator training
The real-time fit factor display assists you in employee respirator training. This feature
allows trainees to see the real-time effects of mask positioning and strap tightness while
learning proper donning techniques.
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•

Viewing, modifying, and printing reports
FitPlus for Windows software generates reports for fit test subjects, respirators, protocols, fit
tests, next due dates, daily check results, and user-defined reports. You have the option of
viewing the reports or printing the reports. You also can customize the reports to include
specific fields only, or to sort the data in a specific order and specific ranges.

•

Setting up communications ports
You can select any of four communications ports on your PC for the FitPlus/PORTACOUNT
communications, depending on your hardware configuration.

•

Modifying setup options
You can customize the setup for saving fit test data, printing fit test data, and alerting you to
failed exercises and failed overall fit factors.

•

Opening and setting up databases
There are four default databases: People, Respirator, Protocol, and Fit Test. You can open
each of these databases to add, delete, duplicate, or search for information. You can also
create new databases.

•

Copying, merging, and exporting databases
These features allow you to move data from one database to another, to merge two databases,
or to export the database to a tab-delimited ASCII file.

FitPlus for Windows software also contains an online help facility.
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Chapter 2
Getting Started
This chapter describes how to install FitPlus for Windows software. It also describes how to
connect the PORTACOUNT Plus Model 8020 to your computer.

Installing FitPlus for Windows Software
To install FitPlus for Windows, you must have the following minimum hardware and software
configurations:

Hardware Requirements
•
•
•
•
•
•

PORTACOUNT Plus Model 8020
386 or higher microprocessor
5 MB free hard-disk space for program files
Windows-compatible printer
Serial port
Pointing device

Software Requirements
•
•

Microsoft Windows 3.x, Windows 95, or Windows NT
FitPlus for Windows disk

Installation Procedures
The procedures for installing FitPlus for Windows are different for Windows 3.x or
Windows 95/NT. Both procedures are included here.
Note:

If you are upgrading from FitPlus for Windows version 1.32 or lower, you should install
version 2.0 into the existing directory (folder). This is usually C:\fpwin. Version 2.0 will
automatically convert existing databases to the new format if necessary without loss of
data. Original data files will be backed up with the file extension “.old”. Converted files
cannot be used with versions prior to 2.0.

Installing FitPlus for Windows with Windows 3.x
1.
2.
3.
4.

Insert the FitPlus disk into drive A:.
In the Program Manager, click the File Menu and choose Run.
Type A:SETUP in the Command Line box.
Click OK.

The setup procedure creates the TSI Products group if it is not already present on your PC. The
FitPlus for Windows icon appears in this group.
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Installing FitPlus for Windows with Windows 95/NT
1.
2.
3.
4.
5.

Insert the disk into drive A:.
Choose Run from the Start menu.
Type A:SETUP in the Open bar.
Click OK.
Follow the installation instructions on the screen.

The setup procedure creates the TSI Products group if it is not already present on your PC. When
you select Programs from your Start menu, TSI Products appears on the list. Highlight TSI
products and then select FitPlus for Windows.

Connecting the PORTACOUNT Plus
The PORTACOUNT Plus connects to the serial port on your computer. The PORTACOUNT Plus is
shipped with an RS-232 interface cable with an 8-pin RJ 45 modular connector on one end and a
25-pin or 9-pin female connector marked “COMPUTER” on the other end. (Do not confuse this
with the TSI printer cable, which has a 9-pin male connector and is marked “PRINTER”.) As
many computers have more than one serial port and may have either 25-pin or 9-pin connectors,
TSI supplies an adapter with the PORTACOUNT Plus to adapt the connector if necessary.
Follow the instructions below to connect your PORTACOUNT Plus to your computer:
Note: IBM-PC compatible serial ports always have pins (male) on the computer side. Ports with
holes (female) are not serial ports.

Using the 25-pin Cable with the 25-pin Computer Port
1. Plug the 25-pin RS-232 cable into the 25-pin connector on the back of your computer.
2. Tighten the keeper screws to prevent the cable from accidentally disconnecting.
3. Plug the other end of the cable into the Data Port located on the back of the PORTACOUNT
Plus.

Using the 25-pin Cable with the 9-pin Computer Port
1.
2.
3.
4.

Connect the small end of the adapter to the 9-pin serial port connector on your computer.
Tighten the keeper screws to prevent the cable from accidentally disconnecting.
Connect the 25-pin RS-232 cable to the 25-pin end of the adapter.
Plug the other end of the cable into the Data Port located on the back of the PORTACOUNT
Plus.

Using the 9-pin Cable with the 9-pin Computer Port
1. Plug the 9-pin RS-232 cable into the 9-pin connector on the back of your computer.
2. Tighten the keeper screws to prevent the cable from accidentally disconnecting.
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3. Plug the other end of the cable into the Data Port located on the back of the PORTACOUNT
Plus.

Using the 9-pin Cable with the 25-pin Port
1.
2.
3.
4.

Connect the large end of the adapter to the 25-pin serial port connector on your computer.
Tighten the keeper screws to prevent the cable from accidentally disconnecting.
Connect the 9-pin RS-232 cable to the 9-pin end of the adapter.
Plug the other end of the cable into the Data Port located on the back of the PORTACOUNT
Plus.

Setting Up the PORTACOUNT Plus
Before you begin fit testing, you also need to set up the PORTACOUNT Plus. The PORTACOUNT
Plus Operation and Service Manual contains the instructions you need if you are not already
familiar with setting up the instrument.
If you are using the Model 8095 N95-Companion with the PORTACOUNT to fit test filteringfacepiece (disposable) respirators, you also need the Model N95-Companion Operation and
Service Manual.

Getting Started

5

6

Chapter 2

Chapter 3
Conducting a Fit Test - Basic Procedures
This chapter provides the basic procedures you follow to conduct a fit test using FitPlus for
Windows software. These procedures begin by default when you open the software. The chapter
discusses what you must do before you begin fit testing, and presents the dialog boxes you must
fill in to complete a fit test. The dialog boxes are easy to fill in by following the information on
the screen. However, if you need additional information, each dialog box is discussed in detail in
Chapter 4, “Using the FitPlus for Windows Menu Options.”
If this is the first time you have used FitPlus for Windows, you must also set the COM
(communications) port and set up the fit test options for automatically saving fit test results,
automatically printing fit test results, and automatically terminating fit tests. You must do this
before you begin fit testing. Basic instructions for completing these tasks appear in the next
section.
FitPlus for Windows always starts in daily check mode. TSI Incorporated strongly recommends
that you run daily checks of the PORTACOUNT Plus before you run the first fit test.
Each fit test includes five steps:
1. Selecting a person to be fit tested from the People database.
2. Selecting a respirator from the Respirator database.
3. Selecting an exercise protocol from the Protocol database.
4. Entering mask size and operator identification information.
5. Running the fit test.
If this is the first time you have used FitPlus for Windows, your People and Respirator
databases will be empty. The instructions in this chapter and the information in Chapter 4 explain
how to add records to the databases. FitPlus for Windows provides a Protocol database which
includes the most commonly used exercise protocols. If your protocol is not in this database,
FitPlus also lets you add it.

Before you Begin the Fit Test
Before you start the software, you must make sure the PORTACOUNT Plus is connected to the
computer, is on, and is operating properly. Also, if you plan to use the N95-Companion with the
PORTACOUNT Plus, to fit test filtering-facepiece (disposable) respirators, you should connect the
N95-Companion now. Refer to the Model 8095 N95-Companion Operation and Service Manual
for specific information.
•

Check the cable connections to the PORTACOUNT Plus.

•

If the PORTACOUNT Plus is not already running, press the ON/OFF key on the to begin the
60-second warm-up cycle.

Then, start the software:
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IMPORTANT MESSAGE FOR FIRST-TIME USERS
Start the software as described below, EXCEPT do not run the Daily Checks. Click the Cancel
button in the Daily Checks dialog box. When the Step 1 dialog box appears, also click the
Cancel button. Then, follow the steps below:
1. From the FitPlus main menu (Figure 3-1), select Setup/Communications Port. Choose the
correct Com port from the dialog box and click OK.
2. Select Setup/Fit Test Options. Choose the options you want to apply to your fit tests from
the dialog box and click OK.
3. Select PORTACOUNT/Daily Checks. Run the daily checks (Figure 3-2). When the checks
are complete, click OK.
4. Select PORTACOUNT/Fit Test. The first fit test dialog box appears on your screen (Figure
3-3).
You are now ready to begin fit testing.
Note: Details for the dialog boxes referenced above appear in Chapter 4, “Using the FitPlus
Menu Options,” under the descriptions of the Setup and PORTACOUNT menus.

Figure 3-1. FitPlus for Windows Main Menu
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•

Double-click the FitPlus for Windows icon from your TSI Products group (Windows 3.x), or
select TSI Products/FitPlus for Windows from the list that appears when you select
Programs from your Start menu. A dialog box asking if you want to do the daily checks
appears on your screen (Figure 3-2). Click Yes. The Daily Checks dialog box appears
(Figure 3-3). Run the daily checks at least once a day. When the checks are complete, click
the OK button. The first fit test dialog box appears on your screen (Figure 3-4).

Note: If you did not start the PORTACOUNT before starting the software, or if the PORTACOUNT
has not completed the warm-up period, you will receive this message: PORTACOUNT
is not responding, including suggestions to check the PORTACOUNT and communications
cable connections. Start the PORTACOUNT and wait for the countdown. Click OK to
continue. You may also select Cancel to skip the daily checks.
You are now ready to begin fit testing.

Figure 3-2. Daily Checks Inquiry Dialog Box

Figure 3-3. Daily Checks Dialog Box

Conducting a Fit Test - Basic Procedures
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Step 1 - Select a Person
When the People Database (Step 1) dialog box appears, it shows the record of the first person in
the People database. The records are arranged in alphabetical order.
Note: If this is the first time you have used FitPlus for Windows, your People database will be
blank. The following instructions indicate which buttons you must click to add records to
the database. However, you must refer to Chapter 4, Using the FitPlus for Windows
Menu Options, for detailed descriptions of the fields in the database dialog boxes.

Figure 3-4. People Database (Step 1)

If the person shown is the one you want to fit test, click the Next button. Otherwise:
1. Click the Sorted List field arrow to display all the names in the People database, or use the
Search button to find the name you need.
Note: If the person you want to fit test is not in the database, or if the record is blank, click
the New button and create a new record.
2. Click the selected person’s name to display the correct record.
3. Click the Next button to proceed to Step 2.
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Step 2 - Select a Respirator
When the Respirator Database (Step 2) dialog box appears, it shows the name of the first
respirator in the Respirator database. The records are in alphabetical order (Figure 3-5).
Note: If this is the first time you have used FitPlus for Windows, your Respirator database will
be blank. The following instructions indicate which buttons you must click to add records
to the database. However, you must refer to Chapter 4, Using the FitPlus for Windows
Menu Options, for detailed descriptions of the fields in the database dialog boxes.

Figure 3-5. Respirator Database (Step 2)

If the record for the respirator you want to use is displayed, click the Next button. Otherwise:
1. Click the Respirator List field arrow to display all the respirators in the database. Use the
scroll bar to find the respirator you need.
Note: If the name of the respirator you want to use is not in the database, or if the record is
blank, click the New button and create a new record.
2. Click the selected respirator name to display it in the records field. If you want to see details
for the selected respirator, click the Detail box to display the Respirator details dialog box
(Figure 3-6).
3. Click the Next button to proceed to Step 3.

Conducting a Fit Test - Basic Procedures
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Figure 3-6. Respirator Details Dialog Box

Note: The following warning appears if the N95-Companion is connected to the PORTACOUNT
Plus but should not be used to fit test the selected mask.

Figure 3-7. N95-Companion Connected Warning
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Respirators equipped with particulate filters having 99% or greater efficiency should be fit tested
without using the optional Model 8095 N95-Companion. This allows you to measure high fit
factors more precisely. If you choose to ignore the warning and use the N95-Companion, the
highest fit factor you can measure is 200.
Note: The following warning appears if the N95-Companion is not connected to the
PORTACOUNT Plus but should be used to fit test the selected mask.

Figure 3-8. N95-Companion Not Connected Warning

Most respirators equipped with particulate filters having less than 99% efficiency should be fit
tested using the optional Model 8095 N95-Companion with the PORTACOUNT Plus. If you choose
to ignore the warning, artificially low fit factors will occur. This can cause a respirator with a
good fit to fail the test.
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Step 3 - Select a Protocol
When the Protocol Database (Step 3) dialog box appears, it shows the exercise protocol that was
last used (Figure 3-9).
Note: If this is the first time you have used FitPlus for Windows software, the dialog box
displays the most commonly used 6-exercise protocol named “Default.” The protocols
are listed in alphabetical order.

Figure 3-9. Protocol Database (Step 3)

If you want to use this protocol, click the Next button. Otherwise:
1. Click the Sorted Records field arrow to display all the exercise protocols in the database.
Use the scroll bar to find the protocol you need.
Note: If the name of the protocol you want to use is not in the database, or if the record is
blank, click the New button and create a new record.
2. Click the selected protocol name to display it in the Sorted Records field. If you want to see
details for this protocol, click the Details box to display the Protocol details dialog box
(Figure 3-10).
3. Click the Next button to proceed to Step 4.
Note: FitPlus for Windows remembers the protocol you last used and defaults to that protocol
for the next fit test. If you always use the same protocol, this saves you from searching for
it over and over again.
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Figure 3-10. Protocol Details Dialog Box

Click the View button in the Sample Timing area of the Protocol Details dialog box to display
the Sample Timing Details dialog box appears (Figure 3-11). The exercise protocol timing
details shown on the screen differ depending on whether or not the N95-Companion is connected
to the PORTACOUNT Plus. When you use the PORTACOUNT Plus alone, or if you enter data
manually, PORTACOUNT Plus timing details appear. When you use the N95-Companion with the
PORTACOUNT Plus, N95 Companion timing details appear.
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Figure 3-11. Sample Timing Details Dialog Box
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Step 4 - Information
When the Information (Step 4) dialog box appears, the mask size and operator fields are blank.
(Figure 3-12.) You must fill in these fields before the FitPlus software will let you continue.

Figure 3-12. Information (Step 4) Dialog Box

1. Fill in the Mask Size field. For example: SMALL, MEDIUM, or LARGE. This is a
required field.
2. Fill in your name in the Operator field. This is a required field.
3. Override the Pass Level and Due Date by typing in new information, if necessary.
4. Click the Next button to proceed to Step 5.
Note: The default setting for data input is PORTACOUNT. If you want to input data manually,
click Manual. When you click the Next button, the Manual Entry - Step 5 of 5 (Figure 314) screen appears. You can use this screen to fill in information from a fit test conducted
without the computer.
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Step 5 - Conducting the Fit Test
The Fit Test (Step 5) dialog box (Figure 3-13) is not active until you begin the fit test by clicking
the Start button. Before you click the Start button, make sure the PORTACOUNT sample tube is
connected to the respirator and the test subject is ready to begin the exercise protocol
immediately. Refer to the PORTACOUNT Plus Operation and Service Manual if you need
additional information. If you are also using the N95-Companion, refer to the Model 8095 N95Companion Operation and Service Manual.

Figure 3-13. Fit Test (Step 5) Dialog Box

1. Click the Start button. The fit test begins immediately and the first exercise description
appears in large type. The elapsed exercise time appears in the Time box. As each exercise
is completed, the results appear in the grid at the lower left of the screen. The Ambient and
Mask fields show the ambient and mask particle concentrations as they are measured.
2. FitPlus prompts you when it begins a new exercise. The exercises proceed one after another
without pause.
3. When the fit test is complete, the main portion of the dialog box displays either a pass or fail
status. The grid at the lower left of the screen displays the results of each exercise and the
overall fit factor. You can now begin a new fit test on another person by clicking the New
test button, redo the test on the same person/respirator by clicking the Redo test button,
cancel fit testing by clicking the Cancel button, or view the detailed fit test record by clicking
the View record button.
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Alternate Step 5 - Manual Entry
If you clicked the Manual button in Step 4, you will be allowed to edit the test date and time if
necessary. If you then click Next, the Manual Entry (alternate Step 5) screen appears (Figure 314). You use this screen to enter the results of a fit test conducted without a computer. Fill in the
results in the Fit Factor column of the screen. After you complete the manual entry of data, you
can begin a new fit test on another person by clicking the New test button, or go on to view the
detailed fit test record by clicking the View record button.

Figure 3-14. Manual Entry (Alternate Step 5)
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View Record (optional)
Clicking View Record at the completion of a fit test allows you to look at the detailed
information from the fit test you just finished (Figure 3-15). You cannot edit the information
from this dialog box, but you may view all information and optionally print a single page fit test
report. When your are done, click OK to begin fit testing another person.

Figure 3-15. Fit Test Record

Summary
This chapter presented the basic fit testing procedures provided by the FitPlus for Windows
software. For detailed information on all the options available in FitPlus for Windows, refer to
Chapter 4.
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Chapter 4
Using the FitPlus for Windows Menu Options
This chapter discusses how to use the FitPlus for Windows menu options to perform all the tasks
available in the FitPlus for Windows software. It is organized in the same order as the FitPlus for
Windows main menu bar, shown in Figure 4-1. You can perform FitPlus for Windows tasks
independently of the default basic procedures discussed in Chapter 3 by selecting them from the
menu.

Figure 4-1. Main Menu
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The following table lists all of the menu selections.
Menu

Description

File

The File menu contains three options:
• Copy Database
• Merge Databases
• Export Database
• Delete Database
• Exit

Database

The Database menu contains two options:
• Open
• Setup/Create Default Filenames

PORTACOUNT

The PORTACOUNT menu contains three options:
• Fit Test
• Realtime
• Daily Checks

Report

The Report menu contains two options:
• Select Report
• Single Fit Test

Setup

The Setup menu contains two options:
• Communications Port
• PORTACOUNT Daily Checks
• N95-Companion Daily Checks
• Fit test Options

Help

The Help menu contains four options:
• Contents
• FitPlus Features
• FitPlus Tasks
• About FitPlus

You can select any of the options using the mouse or the keyboard.
•
•
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To select an item using the mouse, move the cursor to the menu and click the left mouse
button. Then click the menu option you want to select.
To select an item using the keyboard, press the A key and the underlined letter of the menu
you want to select. For example, to select the Database menu, press and hold A, and then
press D. Then, to select the menu option, press the underlined letter for the option you want.

Chapter 4

In addition to the menu bar, FitPlus for Windows includes toolbar buttons. These buttons,
located directly below the menu bar, offer easy access to the most common menu options.

Figure 4-2. Toolbar Buttons

Toolbar button descriptions in order from left to right are:

Copy a database file to another
location and optionally rename the
file

Start a fit test

Start the Real-time fit factor display
Merge one database into another
and optionally rename the file

Export a database to a tab-delimited
ASCII file

Start daily checks

Select a report format from a list

Delete a database

View or print a single-page fit test
report

View or edit the People database

Select or test a communications port

View or edit the Respirator database

Set fit test options

View or edit the Protocol database

Online help

View or edit the Fit Test database

Using the FitPlus for Windows Menu Options
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Using the File Menu
The File menu allows you to copy, merge, or export databases, or to exit the program. FitPlus for
Windows provides a distinct directory structure for the four types of database files: People,
Respirator, Protocol, and Fit Test. Each file type has a specific directory. When you open any of
the Select Source/Destination Database File dialog boxes, explained below, FitPlus for
Windows automatically displays the directory structure in the right-hand side of the dialog box.

Copying a Database
To copy a whole database from one location to another, open the File menu and click Copy
Database. The Copy Database dialog box appears (Figure 4-3).

Figure 4-3. Copy Database Dialog Box

1. Click the Browse button under Select Source Database. The Select source database file
dialog box appears (Figure 4-4).
2. In the Folders list on the right-hand side of the dialog box, double-click the folder for the
type of database you want to copy. The names of the files in the selected folder appear in the
File name list on the left-hand side of the dialog box.
3. Using your mouse, select the name of the database you want to copy. (If the database name
does not appear in the list, search for the desired database in other folders. If you are not
familiar with basic Windows browse techniques, please refer to your Windows
documentation.) The name of the file to be copied must appear in the File name bar at the
top left of the screen. Click the OK button. The Copy Database dialog box reappears with
the name of the source database filled in.
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4. Click the Browse button under Select Destination Database. The Select destination
database file dialog box appears. This dialog box looks exactly like the Select source
database file dialog box, and functions in the same way.
5. The name of the source database file appears in the destination database File name bar by
default. To change the name, type the new name in the bar. (The default destination drive is
A:. If you want to change the drive, select a new drive from the Drives bar at the bottom of
the screen.)
If you want to copy and rename the file, enter the name of the new file in the File name bar
The Copy procedure will copy and rename the file. Click the OK button. The Copy
Database dialog box reappears, with the names of the source and destination databases filled
in.
6. Click the Copy Database button under Execute. The file is copied from the source to the
destination.

Figure 4-4. Select source database file Dialog Box

If you need to cancel the Copy Database procedure at any time, click the Cancel button that
appears on all of the dialog boxes. You immediately return to the main FitPlus window.
If you are on a network, click the Network button on the Select Source/Select Destination
Database file dialog boxes to access other drives on the network.
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Merging Databases
To merge data from one database file into another, open the File menu and click Merge
Databases. The Merge Databases dialog box appears (Figure 4-5). This procedure adds data
from the source database to the destination database. It does not alter the source database file.

Figure 4-5. Merge Databases Dialog Box
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1. Click the Browse button under Select Source Database. The Select source database file
dialog box appears (Figure 4-4).
2. In the Folders list on the right-hand side of the dialog box, double-click the folder for the
type of database you want to merge. The names of the files in the selected folder appear in
the File name list on the left-hand side of the dialog box.
3. Using your mouse, select the name of the source database you want to merge data from. (If
the database name does not appear in the list, search for the desired database in other folders.
If you are not familiar with basic Windows search techniques, please refer to your Windows
documentation.) The name must appear in the File name bar at the top left of the screen.
Click the OK button. The Merge Databases dialog box reappears with the name of the
source database filled in.
4. Click the Browse button under Merge Source Database Into…. The Select destination
database file dialog box appears. This dialog box looks exactly like the Select source
database dialog box, and functions in the same way.
5. Select the name of the database you want to merge data into. Search for the database if it
does not appear in the list. The file must already exist or you cannot execute the merge
function. Click the OK button. The Merge Databases dialog box reappears, with the names
of the source and destination databases filled in.
6. Click the Merge Databases button under Execute. The data is copied from the source
database and added to the destination database. The source database is not altered.
If you need to cancel the Merge Databases procedure at any time, click the Cancel button that
appears on all of the dialog boxes. You immediately return to the previously displayed dialog
box.
If you are on a network, click the Network button on the Select Source/Select Destination
Database file dialog boxes to access other drives on the network.
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Exporting Databases
The Export Database function allows you to transfer data to programs that cannot read
dBASE IV format databases. Most popular database and spreadsheet software can read
dBASE IV format databases directly.
The export database function creates a tab-delimited ASCII file containing all data in the
database. There is no way to filter records.
To export data from one database file into a tab-delimited ASCII file, open the File menu and
click Export Databases. The Export Database dialog box appears (Figure 4-6).

Figure 4-6. Export Database Dialog Box
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1. Click the Browse button under Select Source Database. The Select source database file
dialog box appears (Figure 4-4).
2. In the Folders list on the right-hand side of the dialog box, double-click the folder for the
type of database you want to export. The names of the files in the selected folder appear in
the File name list on the left-hand side of the dialog box.
3. Using your mouse, select the name of the database you want to export. (If the database name
does not appear in the list, search for the desired database in other folders. If you are not
familiar with basic Windows search techniques, please refer to your Windows
documentation.) The name must appear in the File name bar at the top left of the screen.
Click the OK button. The Export Database dialog box reappears with the name of the
source database filled in.
4. Click the Browse button under Select Destination File. The Select destination file dialog
box appears (Figure 4-7).
5. Select the name of the file you want to export the data to.
WARNING: If you select the name of an existing file, the file will be overwritten.
Create a new file by typing the file name in the File name bar, or search for the file if it does
not appear in the list. (The file extension .txt is used by default and may be changed if you
want.) Click the OK button. The Export Database dialog box reappears, with the names of
the source and destination files filled in.
6. Click the Export Database button under Execute. The data is copied from the source to the
destination database.
If you need to cancel the Export Database procedure at any time, click the Cancel button that
appears on all of the dialog boxes. You immediately return to the previously displayed dialog
box.
If you are on a network, click the Network button on the Select Source/Select Destination
Database file dialog boxes to access other drives on the network.
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Figure 4-7. Select destination file Dialog Box - Export Database

Deleting Databases
To delete a database, open the File menu and click Delete Database. The Select file to delete
dialog box appears (Figure 4-8).

Figure 4-8. Select file to delete Dialog Box
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1. In the Folders list on the right-hand side of the dialog box, double-click the folder for the
type of database you want to delete. The names of the files in the selected folder appear in
the File name list on the left-hand side of the dialog box.
2. Using your mouse, select the name of the database you want to delete. (If the database name
does not appear in the list, search for the desired database in other folders. If you are not
familiar with basic Windows search techniques, please refer to your Windows
documentation.) The name must appear in the File name bar at the top left of the screen.
Click the OK button. A dialog box appears, asking if you really want to delete this file.
3. Click Yes to delete the file.
If you need to cancel the Delete Database procedure at any time, click the Cancel button that
appears on all of the dialog boxes. You immediately return to the previously displayed dialog
box.
If you are on a network, click the Network button on the Select file to delete dialog box to
access other drives on the network.

Exiting FitPlus for Windows Software
To exit the program, open the File menu and click Exit. The main FitPlus window closes,
terminating the application.
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Using the Database Menu
FitPlus for Windows uses four types of database files: People; Respirator; Protocol; and Fit Test.
The Database menu allows you to open the database files, add new data to these database files,
change the default database file, or create a new database file.
All database files carry the .dbf extension. The default files supplied with FitPlus for Windows
software are People.dbf, Respirator.dbf, Protocol.dbf, and Fittest.dbf.
The default databases are the databases used for fit testing. In other words, Step 1 of a fit test
uses the default people database, Step 2 uses the default respirator database, Step 3 uses the
default protocol database, and the fit test results are stored in the default fit test database. The
only way you can change a default database is by using the Setup/Create Default Filenames
option, described later in this section.

Opening and Updating the Default Database Files
To open one of the database files, click the Database menu, select Open, and select one of the
four database files: People, Respirator, Protocol, or Fit Test. The first record in the default
database appears. If you want to work on another database that is not currently defined as the
default, click the Open button and select another database from the Select Database File dialog
box.
Note: Each of the four database files is described in a separate section below.
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Updating the People Database File
The People Database dialog box automatically displays the first record in the default people
database (Figure 4-9), sorted by last name. If the database is empty, the dialog box contains all
blank fields. You enter information for a new record in the fields in the People Information
section of the dialog box. You can also change any of the displayed information for any existing
record by overwriting these fields.

Figure 4-9. People Database Dialog Box
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The following table describes the function of each of the buttons or fields in the People Database
dialog box.
Button or Field Name

Function

New button

Clicking the New button opens a new blank record, allowing you to
enter a new record in the database.

Delete button

Clicking the Delete button allows you to delete the displayed
record. A warning message first appears, asking if you are sure
you want to delete the record. If you click Yes, the record is
deleted permanently.

Duplicate button

Clicking the Duplicate button duplicates the displayed record, adds
it to the database, and displays the duplicate record. You can use
this feature to create a record similar to the displayed record, and
edit the fields as necessary.

Search button

Clicking the Search button displays the Database Search dialog
box (Figure 4-10). Type the name of the person you want to find
in the Text to search for… bar and click OK. The People
Database dialog box reappears, displaying the selected record.
You may search other fields besides the last name field by
changing the field shown in the Data to search through .
If the record you are searching for is not in the database file, the
first record in the file reappears. Click New and add the new
record.

ID Number field

Displays the person’s ID number. Limited to 11 alpha-numeric
characters.

Last Name field

Displays the person’s last name. Limited to 25 characters.

First Name field

Displays the person’s first name. Limited to 25 characters.

Company field

Displays the person’s company name. Limited to 25 characters.

Location field

Displays the person’s division or department name. Limited to 25
characters.

Note field

Displays any information about the person that can affect the fit
test circumstances or results, such as “wears safety goggles,” or
“wears dentures.” Limited to 128 characters.
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Button or Field Name

Function

Sorted List field

Clicking the arrow to the right of the sorted list field displays a list
of all the records in the database file. It is used to select a record
for display.

Custom fields (1, 2, 3,
and 4)

Displays any user-defined data you may want to keep track of. The
field names “custom1”, “custom2”, etc. cannot be changed.

Open button

Clicking the Open button displays the Select people database file
dialog box. You can select another file for editing. However, this
does not change the default people database for fit test purposes.

Close button

Clicking the Close button closes the dialog box.

Help button

Clicking the Help button accesses the FitPlus online help
information.

Figure 4-10. Database Search Dialog Box
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Updating the Respirator Database
The Respirator Database dialog box automatically displays the first record in the default
respirator database (Figure 4-11), sorted by description. You use the Respirator List field to
display and select any existing respirator record. If the database is empty, the dialog box contains
all blank fields. You enter information for a new respirator in the Respirator Information
section of the dialog box. You can also change the displayed information for any existing record
by updating the appropriate fields.

Figure 4-11. Respirator Database Dialog Box
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The following table describes the function of each of the buttons or fields in the Respirator
Database dialog box.
Button or Field Name

Function

New button

Clicking the New button opens a new blank record, allowing you to
enter a new record in the database.

Delete button

Clicking the Delete button allows you to delete the displayed
record. A warning message first appears, asking if you are sure
you want to delete the record. If you click Yes, the record is
deleted permanently.

Duplicate button

Clicking the Duplicate button duplicates the displayed record, adds
it to the database, and displays the duplicate record. You can use
this feature to create a record similar to the displayed record, and
edit the fields as necessary.

Search button

Clicking the Search button displays the Database Search dialog
box. (This box is structured exactly like the box shown in Figure
4-10, although it displays respirator information.) Select the data
to search through, and type the information to search for in the
Text to search for… bar. Click OK. The Respirator Database
dialog box reappears, displaying the selected record.
If the record you are searching for is not in the database file, the
first record in the file reappears. Click New and add the new
record.

Sorted Records field

Clicking the arrow to the right of the Sorted Records field displays
a list of all the respirator records in the database. You can select a
new record or leave the current record in the dialog box.

Manufacturer field

Displays the respirator manufacturer’s name.

Model field

Displays the respirator model.

Style field

Displays the description of the respirator style, such as half- or fullface.

Approval field

Displays the respirator approval number. This is typically the
NIOSH approval number.
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Button or Field Name

Function

Fit Factor Pass Level
field

Displays the fit factor pass level number for this respirator, such as
100 for half masks and 500 for full-face masks. Consult the
applicable regulations for additional information.

Description field

Displays the respirator description, also shown in the Sorted
Records field. See Auto Description at the end of this table.

Filter efficiency less
than 99% (N95Companion required)
box

A check mark in this box indicates that the N95-Companion must
be used with the PORTACOUNT Plus to guarantee accurate fit test
results for the selected respirator.
• If the respirator you are fit testing with has HEPA,
class 100 or class 99 filters, leave this box un-checked.
The N95-Companion is not needed.
• If the respirator has DM, DMF or class 95 filters, you
should check this box so that the N95-Companion will
be used (if present).
• International users should leave this box un-checked
for P3 filters and checked for P1 or P2 filters.

Auto Description Check
Box

If Auto Description is checked, the description field will
automatically be filled in using the information from the
manufacturer, model, style and fit factor pass level fields. You
may overwrite the automatic description if necessary.

Open button

Clicking the Open button displays the Select respirator database
file dialog box. You can select another file for editing purposes.
However, this does not change the default respirator database for fit
test purposes.

Close button

Clicking the Close button updates the displayed record and closes
the dialog box.

Help button

Clicking the Help button accesses the FitPlus online help
information.
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Updating the Protocol Database
The Protocol Database dialog box automatically displays the records in the default protocol
database in alphabetical order. (Figure 4-12). You use the Sorted Records field to display and
select any existing exercise protocols. If the database is empty, the dialog box contains all blank
fields. You enter information for a new exercise protocol in the Protocol Information section of
the dialog box. You can also change the displayed information for any existing record by
updating the appropriate fields.

Figure 4-12. Protocol Database Dialog box
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The following table describes the function of each of the buttons or fields in the Protocol
Database dialog box.
Button or Field Name

Function

New button

Clicking the New button opens a new blank record, allowing you to
enter a new record in the database.

Delete button

Clicking the Delete button allows you to delete the displayed
record. A warning message first appears, asking if you are sure
you want to delete the record. If you click Yes, the record is
deleted permanently.

Duplicate button

Clicking the Duplicate button duplicates the displayed record, adds
it to the database, and displays the duplicate record. You can use
this feature to create a record similar to the displayed record, and
edit the fields as necessary.

Search button

Clicking the Search button displays the Database Search dialog
box. (This box is structured exactly like the box shown in Figure
4-10, although it contains only the protocol names.) Type the name
of the protocol for this fit test in the Text to search for… bar and
click OK. The Protocol Database dialog box reappears,
displaying the selected record.
If the record you are searching for is not in the database file, the
first record in the file reappears. Click New and add the new
record.

Protocol Name field

Displays the name of the displayed exercise protocol.

Sorted Records field

Clicking the arrow to the right of the Sorted Records field displays
a list of all the Protocol records in the database. You can select a
new record or leave the current record information in the dialog
box.
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Exercise Name fields

Displays the names of all the exercises in the protocol. There are
up to 12 exercises. Use the scroll bar to the right of the Exclude
buttons to display Exercises 7 through 12.

Mask Time field

Displays the mask sample time in seconds for each exercise. Use
60 seconds unless applicable regulations allow other settings.

Total Time field

Displays the total time in seconds for each exercise. The total time
is the mask plus ambient purge plus ambient sample plus mask
purge times. FitPlus for Windows automatically updates the total
when you move to the next field. You cannot update this field
directly.

Exclude buttons

Clicking the Exclude button for an exercise excludes those
exercise results from the overall fit factor result for the entire fit
test. Do not exclude exercises unless you are absolutely certain
that they are not required for the overall fit factor result.

Ambient Purge field

Displays the ambient purge time in seconds. The default is 4. Do
not change this setting under normal circumstances.

Ambient Sample field

Displays the ambient sample time in seconds. The default is 5. Do
not change this setting under normal circumstances.

Mask Purge field

Displays the mask purge time in seconds. The default is 11. Do
not change under normal circumstances.

Next Test field

Displays the number of months before the next fit test is due. This
is typically 12 months, although some regulations call for 6
months. Consult the applicable regulations for additional
information.

99% and greater button

Clicking the 99% and greater button displays the Sample timing
for PORTACOUNT (alone) dialog box (Figure 4-13). This box lists
Mask Sample Times, Mask Purge Time, Ambient Sample Time,
and Ambient Purge Time when you are conducting a fit test with
the PORTACOUNT alone.

Less than 99% button

Clicking the Less than 99% button displays the Sample timing
for N95-Companion dialog box (Figure 4-14). This box lists
Mask Sample Times, Mask Purge Time, Ambient Sample Time,
and Ambient Purge Time when you are using the N95-Companion
and PORTACOUNT together to conduct a fit test.
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Open button

Clicking the Open button displays the Select protocol database
file dialog box. You can select another file for editing purposes.
However, this does not change the default protocol database used
for fit testing.

Close button

Clicking the Close button updates the displayed record and closes
the dialog box.

Help button

Clicking the Help button accesses the FitPlus online help
information.

Figure 4-13. Sample timing for PORTACOUNT (alone) Dialog Box
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Figure 4-14. Sample timing for N95-Companion Dialog Box
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Viewing the Fit Test Database
The Fit Test Database file dialog box automatically displays the first record in the default fit test
database, sorted by last name (Figure 4-15). Many of the fields in this dialog box are display
only, you cannot modify them.

Figure 4-15. Fit Test Database Dialog Box

You can display a new record by clicking the arrow next to the Sorted Records field and
selecting a new record from the resulting list. You can also click the Search button at the bottom
of the screen to display a dialog box that allows you to select a specific fit test record.
The following table describes the function of each button and field in the Fit Test Database
dialog box. It also indicates whether or not you can modify the field.
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Button or Field Name

Modify?

Function

First Name field
Last Name field
ID Number field
Company field
Location field

Y
Y
Y
Y
Y

Test Date field
Test Time field
Due Date field
Protocol field
Mask Size field
Respirator field

N
N
Y
N
Y
Y

Sorted Records field

n/a

Displays the first name of the fit test subject.
Displays the last name of the fit test subject.
Displays the ID number of the fit test subject.
Displays the company name of the fit test subject.
Displays the division or department name of the fit
test subject.
Displays the date of the fit test.
Displays the time the fit test began.
Displays the date that the next fit test is due.
Displays the protocol used for the fit test.
Displays the size of the mask used for the fit test.
Displays the name of the respirator used for the fit
test.
Clicking the arrow to the right of the Sorted
Records field displays a list of all the Fit Test
records in the database. You can select a new
record or leave the current record information in
the dialog box.

Note field

Y

Displays any information about the person that can
affect the fit test circumstances or results.

Custom fields (1, 2, 3,
and 4)
PORTACOUNT field

Y

Displays any user-defined data.

N

Displays the serial number of the PORTACOUNT
used for the fit test.

Operator field

Y

Displays the name of the operator who conducted
the fit test.

Pass Level field

N

Displays the pass level used for the fit test.

Overall Fit Factor field

N

Displays the overall fit factor result for the fit test.

Overall Pass field

N

Displays a Y for a passed fit test; an N for a failed
fit test.

Protocol button

n/a

Clicking the Protocol button displays the Protocol
Information dialog box (Figure 4-16). To view
detailed exercise protocol information for this fit
test, click the View button.
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Button or Field Name

Modify?

Function

Respirator button

n/a

Clicking the Respirator button displays detailed
information on the respirator used for this fit test
(Figure 4-17).

View results button

n/a

Clicking the View results button displays the
detailed exercise results for this fit test (Figure
4-18).

Search button

n/a

Clicking the Search button displays the Database
Search dialog box. (This box is structured exactly
like the box shown in Figure 4-9, although it
contains fit test information). Select the type of
data to search through, and type the information to
search for in the Text to search for… bar. Click
OK. The Respirator Database dialog box
reappears, displaying the selected record.
If the record you are searching for is not in the
database file, the first record in the file reappears.
Click New and add the new record.

Delete button

n/a

Clicking the Delete button permanently deletes this
record from the fit test database. A warning
message first appears asking if you are sure you
want to delete the record.

Print button

n/a

Clicking the Print button prints a detailed one-page
report for this fit test.

Open button

n/a

Clicking the Open button displays the Select fit
test database file dialog box. You can select
another file for editing purposes. However, this
does not change the default fit test database used
for fit testing.

Close button

n/a

Clicking the Close button updates the displayed
record and closes the database dialog box.

Help button

n/a

Clicking the Help button accesses the FitPlus
online help information.
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Figure 4-16. Protocol Information

Figure 4-17. Respirator Information
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Figure 4-18. Complete Fit Test Results
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Changing the Default Database Files
The default databases are the databases you use for new fit tests. Although you can have
numerous databases in your database directories, only those designated as the defaults are used
for new fit tests. To change the default database files, open the Database menu and select
Setup/Create Default Filenames. The Setup/Create Default Database Filenames dialog box
appears (Figure 4-19).

Figure 4-19. Setup/Create Default Database Filenames Dialog Box

The Setup/Create Default Database Filenames dialog box displays the names of each of the
default databases. Clicking the People, Respirator, Protocol, or Fit Test button displays the
Select xxxxx Database dialog box (Figure 4-20). The dialog box name changes depending on
the database you select.
FitPlus for Windows provides a distinct directory structure for the four types of database files.
Each file type (People, Respirator, Protocol, and Fit Test) has a specific sub-directory under the
main FitPlus for Windows directory (usually C:\FPWIN). When you open any of the Select
xxxxx Database dialog boxes, FitPlus for Windows automatically opens the correct database
directory for the database type you selected.
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Figure 4-20. Select xxxxx Database Dialog Box

Follow these instructions to select a new default database file. The instructions are the same for
all database types.
1. Select Setup/Create Default Filenames from the Database menu. The Setup/Create
Default Database Filenames dialog box appears (Figure 4-19).
2. Select the type of database you want to change. The Select xxxxx Database dialog box
appears (Figure 4-20).
3. Using your mouse, select the name of the new default database. (If the database name does
not appear in the list, search for the desired database in other folders. If you are not familiar
with basic Windows search techniques, please refer to your Windows documentation.) The
name must appear in the File name bar at the top left of the screen after you have selected it.
If you want to create a new database, type the new file name into the file name bar.
4. Click the OK button. The Setup/Create Default Database Filenames dialog box reappears
with the name of the new default database displayed in the field next to the appropriate
button. Click the Protected box next to the database name to protect existing records in the
database from being changed. With this box selected, you can only add new records to the
database, but you cannot edit existing records.
5. To edit the new database file, return to the Database menu. Select Open. Refer to the
instructions in the previous section, “Opening/Updating the Default Database Files,” if you
need additional information.
You now see this default database file when you select Open from the Database menu, and when
you begin a fit test.

50

Chapter 4

You can cancel the selection at any time by clicking the Cancel button to return to the
Setup/Create Default Database Filenames dialog box.
If you are on a network, click the Network button on the Select or create default database
dialog box to access other drives on the network.

Creating New Default Database Files
To create new database files, open the Database menu and select Setup/Create Default
Filenames. The Setup/Create Default Database Filenames dialog box appears (Figure 4-19).
Click the button for the type of database file you want to create. The Select xxxxx Database
dialog box appears (Figure 4-20).
Follow these instructions to create a new default database file. The instructions are the same for
all database types.
1. Click the File name field of the Select xxxxx database dialog box. Enter the name of your
new database file. Overwrite the name already in the box if necessary. You do not need to
include the .dbf file extension.
2. Click the OK button. The Setup/Create Default Filenames dialog box reappears, with the
new database name in the field next to the appropriate button.
3. Click the OK button to return to the main menu. Open the Database menu and select Open,
choosing the type of database file you just created. The database opens and displays a blank
record.
4. Complete all the necessary fields in the new record. Refer to the tables earlier in this chapter
for descriptions of the fields. When you are finished, click the New button to display another
blank record.
5. Add all your new records. After you have added the last record, click OK. The main menu
reappears.
To view your new file, select the appropriate database type using Open from the Database menu.
The first record of your new file appears in the database dialog box.
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Using the PORTACOUNT Menu
FitPlus for Windows software allows you to run daily diagnostic tests and provides real-time fit
factor displays for use in employee respirator training. Both of these selections are available from
the PORTACOUNT menu. The PORTACOUNT menu also includes a Fit Test selection.

Conducting a Fit Test
To begin the fit test, open the PORTACOUNT menu and select Fit test. The People Database
dialog box appears. The fit test procedure is identical to the procedure described in Chapter 3,
“Conducting a Fit Test - Basic Procedures.” Please refer to Chapter 3 for additional information.

Displaying Real-time Fit Factors
FitPlus for Windows software allows you to display real-time fit factors to assist in employee
respirator training. This allows a person to experiment with respirator straps and fit while
watching the effect in real-time. The person then learns how each adjustment affects the fit, and
learns how to achieve a fit that is comfortable and has minimum leakage. This feature is intended
for classroom training and should not be used immediately before a fit test. Using the feature to
help the test subject immediately before the official fit test defeats one of the main purposes of fit
testing: to prove that the test subject knows how to don the mask properly without help. Use
the Real-time Fit Factor feature in the classroom for training and practice only.
Note:

You can use the real-time fit factor display just prior to a fit test as long as you have the
test subject remove the mask and put it on again (without help) before the final test.

Before you start the real-time fit factor display, you must have the PORTACOUNT on and properly
attached to the computer, and must have someone wearing a respirator that is properly attached to
the PORTACOUNT.
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To begin the display, open the PORTACOUNT menu and select Realtime. The Realtime Fit
Factor Display dialog box appears. Figure 4-21 shows the realtime fit factor when only the
PORTACOUNT Plus is in use. Figure 4-22 shows the realtime fit factor when the PORTACOUNT
Plus is used with the N95-Companion.

Figure 4-21. Realtime Fit Factor Display - PORTACOUNT Only Dialog Box
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Figure 4-22. Realtime Fit Factor Display - N95-Companion Only Dialog Box

Because this dialog box monitors a process as it occurs, you cannot modify any of the fields
manually. You can observe which process is occurring in the Status field, see the actual readings
for the Ambient and Mask Purges and the Fit Factor in the Readings field, and watch the Fit
Factor reading fluctuate in the graph portion of the dialog box. You can also stop the display by
clicking the Cancel button, and stop and restart the display by clicking the Restart button. The
display pauses periodically while the PORTACOUNT takes an ambient reading. Clicking the
Restart button forces a new ambient reading immediately.

54

Chapter 4

Performing Daily PORTACOUNT Checks
Daily checks consist of the particle check, zero check, and maximum fit factor check. There is
also an optional valve check. TSI Incorporated strongly recommends daily checks of the
PORTACOUNT before you begin fit testing. FitPlus for Windows software provides a very easy
way for you to complete these checks. Daily Check results are automatically recorded in a
database named daily.dbf. This database is located in the directory that holds the FitPlus for
Windows executable files (usually C:\FPWIN).
FitPlus for Windows automatically initiates the daily checks when you first start the program.
The PORTACOUNT must be on and the 60-second countdown must be completed for this to
work. You may click Cancel to skip the checks.
To start the daily checks manually, open the PORTACOUNT menu and select Daily Checks.
The Daily Checks dialog box appears (Figure 4-23).

Figure 4-23. Daily Checks Dialog Box

Note: The Daily Check process detects whether or not the N95-Companion is attached to the
PORTACOUNT Plus and adjusts the pass/fail values accordingly. Figure 3-3 shows
pass/fail values for the PORTACOUNT Plus alone.
The dialog box instructs you to remove the HEPA filter or mask and press Start. Once you click
the Start button, the daily check process begins and the status appears in the middle of the dialog
box, with the elapsed time in seconds appearing in the bar at the bottom of the dialog box.
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Note: If you want to change the settings for the Daily Checks before starting, click the Settings
button. Either the Daily Checks Settings for PORTACOUNT Alone dialog box (Figure
4-24) or the Daily Checks Setting for N95-Companion dialog box (Figure 4-25) appears,
depending on your system configuration. Each dialog box displays the current settings
and allows you to reset them. Do not change these settings unless you are sure you should
do so.

Figure 4-24. Daily Checks Settings for PORTACOUNT Alone Dialog Box
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Figure 4-25. Daily Checks Settings for N95-Companion Dialog Box

The Particle check is performed first. After the Particle check is complete, the dialog box
instructs you to attach a HEPA filter and press Start again. This starts the Zero check and
Maximum Fit Factor check.
When these checks are complete, you can click the OK button to save the results and close the
dialog box, or click Advanced to run the optional Valve check. The dialog box instructs you to
again remove the HEPA filter and press Start. This starts the Valve check. When the Valve
check is complete, all the test results appear in the dialog box. Click the OK button to save the
results and close the dialog box. The results are saved in a database called daily.dbf. You can
access them through the Report menu, discussed in the next section.
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Using the Report Menu
FitPlus for Windows provides the following reports:
•
•
•
•
•
•
•
•

People Database report
Respirator Database report
Protocol Database report
Fit test Database report
Next Due report
Daily check Results report
DOS Fit Test Database report
User defined reports 1 through 4 (You can rename and customize these reports.)

You can access these reports by opening the Report menu and selecting Select Report. The
Report List dialog box appears (Figure 4-26).

Figure 4-26. Report List Dialog box
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The People Database is the first in the list, and is highlighted. The name of the database file
used for the report appears across the top of the dialog box. This is the default database, although
you can choose another database if you wish. The number of records included in the highlighted
report appears in the field under the list. The following table describes each of the fields and
buttons in the Report List dialog box.

Button or Field Name

Function

Report List field

Displays the names of the reports provided by FitPlus for
Windows.

Number of Records field

Displays the number of records contained in the report highlighted
in the Report List field.

Database File button

Clicking the Database File button opens the Select xxxxx
Database (Figure 4-20) dialog box and allows you to choose
another database for report purposes. The Select xxxxx Database
dialog box is described previously in the “Changing the Default
Database Files” section.
Note: Selecting another database in this dialog box does not
permanently change the default database used for fit testing.
If you do select another file for report purposes and click the OK
button, the new filename then appears at the top of the Report List
dialog box.
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Button or Field Name

Function

Modify Report button

Clicking this button displays the Select Fields to Use for Sorting
dialog box (Figure 4-27). This dialog box lets you select fields to
use for sorting reports. To select a new field:
1. Use your mouse to highlight the sort field name on the left
hand list. You can add more than one field if you wish.
Note that the right-hand list has <end of list> highlighted. Any
fields you add to the list appear at the end of the list by default.
If you want to insert the fields elsewhere in the list, highlight
the field name that you want the new field to appear above.
The order of the fields in the right-hand list determines the sort
order of the fields in your report.
2. Click the Add arrow. The names appear in the right hand list.
These fields are now used in order to sort the selected report.
3. To remove sort fields, be sure they are highlighted in the right
hand list and click the Remove arrow. The names move back
into the left hand list and are not used for sorting.
Click the Next button at the bottom of the Select Fields to Use for
Sorting dialog box. The Select Records to Include in Report
dialog box appears (Figure 4-28). If you want to include all
records in the report, click the All Records button at the top left of
the dialog box. To include selected records only, click Selected
Records and choose the field you want to use for filtering in the #1
Select Record with section of the screen, such as Company or
Last Name; the filtering operation, such as “equal to” or “greater
than”; and the specific filter criteria, such as an actual company
name. You can include a second criteria by clicking the And
button and completing the #2 Select Record with section of the
screen, click None to use no second criteria, or click Or to use the
second criteria only. Click the Next button to redisplay the Report
List. Click View Report to display your modified report. All
changes to your reports are saved.
TO MODIFY USER DEFINED REPORTS
If you selected a user defined report to modify, the Rename
Report Title (Optional) dialog box appears (Figure 4-29). Type a
name for the report if you wish and click Next. The Select
Database dialog box appears (Figure 4-30). Choose the type of
database you want to associate with this report and click Next. The
Select Fields to Include in Report dialog box appears (Figure 431). Choose the fields you want in your report and click Next.
The Select Fields to Use for Sorting dialog box appears. Refer to
the beginning of this Modify Report button description.
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Button or Field Name

Function

View Report button

Clicking this button displays the first record in the selected report.
Click Next to view the next record in the report. Click Close to
return to the Report List dialog box. To select another database,
refer to the Database File button description above.

Print Report button

Clicking this button sends the selected report to your designated
printer. The entire multi-page report is printed. If you want to
print selected records only, refer to the Modify report button
description above.

Close button

Clicking this button closes the Report List dialog box.

Help button

Clicking this button accesses the FitPlus online help information.

Figure 4-27. Select Fields to Use for Sorting Dialog Box

Using the FitPlus for Windows Menu Options

61

Figure 4-28. Select Records to Include in Report Dialog Box

Figure 4-29. Rename Report Title (Optional) Dialog Box
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Figure 4-30. Select Database Dialog Box

Figure 4-31. Select Fields to Include in Report Dialog Box

When you display the reports using the View report button described in the above table, the first
record in the report appears on the screen. All reports have a Next and a Close option in the
menu bar across the top of the report screen. Click Next to view the next record in the report.
Click Close to return to the Report List dialog box.
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Report Examples
The following examples include instructions for generating four different types of reports: a Next
Due report; a single page Fit Test report; a user defined report; and report based on FitPlus for
DOS database files. Although these are only a representative sample of the many reports you can
generate with FitPlus for Windows, the examples show how to navigate through the many Report
dialog boxes, and should provide some basic guidelines for generating other types of reports.

Example 1 - Next Due Report
Follow the steps below to generate a report showing who is due for a fit test. This report will
have one record per line.
1. Open the Report menu and choose Select Report. From the Report List dialog box, select
Next Due. The report obtains the data from the default Fit Test database. If you want to use
a different Fit Test database, click Database File and choose another one. The name of the
database file used for the report always appears across the top of the Report List dialog box.
2. Click Modify Report to choose the fields to use for sorting: for example, Last Name and ID
number. If you do not select any fields, the report appears blank when you view it.
3. Click the Next button to choose the records to include in the report: for example, click
Selected Records and choose Due Date less than xx/xx/1996, using whatever date you wish.
4. Click None for the #2 filter.
5. Click Next and choose View Report or Print Report. The report shows all people due for a
fit test prior to the date you entered.

Example 2 - Single Page Fit Test Report
Follow the steps below to generate a single page fit test report. Each fit test will be printed on a
separate page.
1. Open the Report menu and choose Select Report. From the Report List dialog box, select
Fit Test Database. The report obtains the data from the default Fit Test database. If you
want to use a different database, click Database File and choose another one. The name of
the database file used for the report always appears across the top of the Report List dialog
box.
2. Click Modify Report to choose the fields to use for sorting. If you do not select any fields,
the report appears blank when you view it.
3. Click the Next button to choose the records to include in the report: for example Company
equal to ABC.
4. Click None for the #2 filter.
5. Click Next and choose View Report or Print Report. The report shows each fit test report
on a separate page.
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Example 3 - User Defined Reports
Follow the steps below to generate a user-defined report.
1. Open the Report menu and choose Select Report. From the Report List dialog box, select
User Defined 1.
2. Click Modify Report and type a name for the report in the Rename Report Title (Optional)
dialog box.
3. Click Next and choose the type of database you want to take the data from. The report will
obtain data from the default database.
4. Click the Next button to choose the fields to include in the report. The report will be
structured in columns with one field per column. The first field in the list is used for column
one, the second field for column two, and so forth.
5. Click Next and select the fields to use for sorting the report.
6. Click Next and select the records to include in the report.
7. Click Next and choose View Report or Print Report.
Note: If you want to change the database used for the report, click Database File and select
a different one.

Example 4 - Reports Based on FitPlus for DOS Data Files
Follow the steps below to generate a report based on a FitPlus for DOS database file.
1. Open the Report menu and choose Select Report. From the Report List dialog box, select
DOS Fit Test Database.
2. Click Database File to choose a FitPlus for DOS database file. You can usually find these
files in the FitPlus directory on your hard drive. The most commonly used file name is
testdata.dbf. When you have chosen the file, click OK.
3. Click Modify Report and select a field to sort on.
4. Click Next and choose All Records or Selected Records from the Select Records to
Include in Report dialog box.
5. Click Next and choose View Report or Print Report. A one page report from each fit test is
displayed or printed.
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Using the Setup Menu
The four selections on the Setup menu allow you to select the communications port for your
computer, change Daily Checks settings depending on your system configuration, and change the
default fit test options.

Selecting the Communications Port
To select the communications port for the PORTACOUNT, open the Setup menu and choose
Communications port. The Communications Port dialog box appears (Figure 4-32).

Figure 4-32. Communications Port Dialog box

Make sure your PORTACOUNT is attached to your computer, the power is on, and the 60-second
countdown is complete. If you don’t know which port number the instrument is attached to, click
Auto Find. The software will assign the correct port number.
If you do know the port number, click Com1, Com2, Com3, or Com4. Then, click Test. The
software will verify that you have selected the selected the correct port.
Clicking OK saves the information, closes the dialog box, and returns you to the main menu.
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Changing Daily Checks Settings
To change Daily Checks settings when you are using the PORTACOUNT Plus alone, open the
Setup menu and select PORTACOUNT Daily Checks. The Daily Checks Settings for
PORTACOUNT Alone dialog box appears (Figure 4-24). Refer to the “Using the PORTACOUNT
Menu” section earlier in this chapter for additional information.
To change Daily Checks settings when you are using the PORTACOUNT Plus with the N95Companion, open the Setup menu and select N95-Companion Daily Checks. The Daily
Checks Settings for N95-Companion dialog box appears (Figure 4-25). Refer to the “Using the
PORTACOUNT Menu” section earlier in this chapter for additional information.

Changing the Default Fit Test Options
To change the default fit test options, open the Setup menu and select Fit test options. The Fit
Test Options dialog box appears (Figure 4-33).

Figure 4-33. Fit Test Options Dialog box

The default settings are to automatically save all fit tests, to not automatically print fit test results,
to not automatically terminate fit testing, and to include signature lines on reports. Once you
have made any changes to these options, click OK. The dialog box closes, the options are
changed, and the main menu reappears.
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Automatic Save and Automatic Print
To change the Automatic Save and Automatic Print options, click the options you want.
Automatic Save allows you to:
•

Save every fit test, regardless of the end result (except manually terminated fit tests).

•

Save passed fit tests only

•

Never save fit tests

Automatic Print allows you to:
•

Print all fit tests, automatically at the end of each test

•

Print passed fit tests only, automatically at the end of each test

•

Never print automatically

You must have the printer attached to the computer with the power on during fit testing to use the
autoprint options.

Automatic Termination
Automatic termination allows you to terminate a fit test when only one exercise fails, or when it
is certain that the overall fit factor will fail.
Failed Exercise
Technically, it is possible to fail an exercise but still pass the overall test. If you want to require
that all exercises pass, select the Failed Exercise box.
Failed Overall
FitPlus for Windows always warns you when a fit test in progress is progressing so poorly that a
passing fit factor is impossible. The fit test continues as usual until the last exercise is complete.
The fit test then fails. If you would like to terminate fit tests automatically when an overall
failure warning appears, select the Failed Overall box.

Signature Lines
The default setting is to show signature lines on single-page fit test reports. If you do not want
signature lines, click the checked box to deselect this feature.
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